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ONA-800 Getting Started Guide 

Notice

Every effort was made to ensure that the information in this manual was accurate at the 
time of printing. However, information is subject to change without notice, and VIAVI 
reserves the right to provide an addendum to this manual with information not available 
at the time that this manual was created.

Copyright/Trademarks 

© Copyright 2023 Viavi Solutions Inc. All rights reserved. No part of this guide may be 
reproduced or transmitted, electronically or otherwise, without written permission of the 
publisher. VIAVI Solutions and the VIAVI logo are trademarks of Viavi Solutions Inc. 
(“VIAVI”). 

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth 
SIG, Inc. and any use of such marks by VIAVI is under license.

All other trademarks and registered trademarks are the property of their respective 
owners. 

Copyright release 

Reproduction and distribution of this guide is authorized for US Government purposes 
only.

Terms and conditions

Specifications, terms, and conditions are subject to change without notice. The provi-
sion of hardware, services, and/or software are subject to VIAVI’s standard terms and 
conditions, available at www.viavisolutions.com/en/terms-and-conditions.

Open Source Disclaimer - IMPORTANT READ CAREFULLY

The ONA-800 includes third party software licensed under the terms of separate open 
source software licenses.  By using this software you agree to comply with the terms 
and conditions of the applicable open source software licenses.  Software originated 
by VIAVI is not subject to third party licenses.  Terms of the VIAVI Software License 
different from applicable third party licenses are offered by VIAVI alone.

http://www.viavisolutions.com/terms
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Regulatory compliance

This section covers the following information:

• “Safety and compliance information” on page vi
• “California Proposition 65” on page vi
• “Federal Communications Commission (FCC)” on page vi
• “EU WEEE and Battery Directives” on page vii
• “EU REACH” on page viii
• “EU CE Marking Directives (LV, EMC, RoHS)” on page viii
• “Korea Certification” on page ix
• “Pollution Degree 2 Category under IEC 61010-1” on page ix
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Safety and compliance information
Safety information is provided in the document Safety Instructions - ONA-800 Base 
Unit, 22137678, which is shipped with the ONA-800. Compliance information is listed 
below.

California Proposition 65
California Proposition 65, officially known as the Safe Drinking Water and Toxic 
Enforcement Act of 1986, was enacted in November 1986 with the aim of protecting 
individuals in the state of California and the state's drinking water and environment from 
excessive exposure to chemicals known to the state to cause cancer, birth defects or 
other reproductive harm.

For the VIAVI position statement on the use of Proposition 65 chemicals in VIAVI 
products, see the Hazardous Substance Control section of the VIAVI Policies & 
Standards web page.

Federal Communications Commission (FCC)
This device complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation.

The equipment was tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in 
a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference, in which case you 
will be required to correct the interference at your own expense.

The authority to operate this equipment is conditioned by the requirements that no 
modifications be made to the equipment unless the changes or modifications are 
expressly approved by VIAVI.

This product complies with 47 CFR Part 15 through the use of a modular component 
authorized under a grant of certification:

• FCC ID: WUW-SXPCEAC2

Caution:

• This equipment complies with the FCC RF radiation exposure limits set forth for 
an uncontrolled environment. 

https://www.viavisolutions.com/en-us/corporate/legal/policies-standards#sustain
https://www.viavisolutions.com/en-us/corporate/legal/policies-standards#sustain
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• To comply with FCC RF exposure compliance requirements, a separation 
distance of at least 0 cm must be maintained between the antenna of this device 
and all persons.

• To ensure RF exposure compliance while the equipment is body-worn, please 
use only VIAVI part numbers EHARNESS or ONA-800-HN and avoid using other 
body-worn accessories containing metallic components.

• This transmitter must not be co-located or operating in conjunction with any other 
antenna or transmitter.

Innovation, Science and Economic Development Canada (ISED)
This device contains license-exempt transmitter(s)/receiver(s) that comply with 
Innovation, Science and Economic Development Canada’s license-exempt RSS(s). 
Operation is subject to the following two conditions: 

1 This device may not cause interference. 

2 This device must accept any interference, including interference that may cause 
undesired operation of the device.

Le présent appareil est conforme aux d’Innovation, Sciences et Développement 
économique Canada applicables aux appareils radio exempts de licence. L'exploitation 
est autorisée aux deux conditions suivantes: 

1 l'appareil ne doit pas produire de brouillage,

2 l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si 
le brouillage est susceptible d'en compromettre le fonctionnement.

Device operation in the band 5150-5250 MHz is for indoor use only.

Dans la bande de fréquence 5150-5250 Mhz, l'utilisation du produit doit être 
uniquement en intérieur.

EU WEEE and Battery Directives
The equipment, and the batteries used to power it, should not be disposed of as 
unsorted municipal waste and should be collected separately and disposed of 
according to your national regulations.

VIAVI has established a take-back process in compliance with the EU Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2012/19/EU, and the EU Battery 
Directive, 2006/66/EC. Instructions for returning waste equipment and batteries to 
VIAVI can be found in the WEEE section of the  VIAVI Policies & Standards web page. 

If you have questions concerning the disposal of your equipment or batteries, contact 
the VIAVI WEEE Program Management team at weee.emea@viavisolutions.com. 

mailto:weee.emea@viavisolutions.com
mailto:weee.emea@viavisolutions.com
https://www.viavisolutions.com/en-us/corporate/legal/policies-standards#sustain
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EU REACH
Article 33 of EU REACH regulation (EC) No 1907/2006 requires product suppliers to 
provide information when a substance included in the list of Substances of Very High 
Concern (SVHC) is present in an product above a certain threshold.

For information about the presence of REACH SVHC in VIAVI products, see the 
Hazardous Substance Control section of the VIAVI Policies & Standards web page.

EU CE Marking Directives (LV, EMC, RoHS)
The equipment conforms with all applicable CE marking directives. Please request an 
EU Declaration of Conformity for further details.

EU Radio Equipment Directive
In accordance with Article 10.8 of the EU Radio Equipment Directive 2014/53/EU, the 
following table provides information on the frequency bands and the maximum RF 
transmit power of this product for sale in the EU.

Frequency range (MHz) Channels used Max. Transmit Power (dBm/
mW)

2402-2480 0-78 9dBm (8mW)
2412-2462 1-11 20.5dBm (112mW)
5180-5240 36-48 15.5dBm (36mW)
5260-5320 52-64 15.5dBm (36mW)
5500-5700 100-140 15.5dBm (36mW)
5745-5825 149-165 15dBm (32mW)

https://www.viavisolutions.com/en-us/corporate/legal/policies-standards#sustain
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Korea Certification

Japan Radio Law
.当該機器には電波法に基づく、技術基準適合証明等を受けた特定無線設備を装着し
ている。

電波法により5.2/5.3 GHz帯は屋内使用に限ります

Safety standards compliance
The equipment meets the following standards and requirements:

• UL 61010-1 / CAN/CSA-C22.2 No.61010-1-12  Safety Requirements for Electrical 
Equipment for Measurement Control, and Laboratory Use - Part I: General 
Requirements; 3rd edition, Rev 7/19/2019

• IEC 61010-1:2010/AMD1:2016 / EN 61010-1:2010/A1:2019 Safety Requirements 
for Electrical Equipment for Measurement Control, and Laboratory Use - Part I: 
General Requirements

• IEC 60825-1:2014 / EN 60825-1:2014 Safety of laser products - Part 1: 
Equipment classification and requirements

• Installation Category (Over voltage Category) II under IEC 60664-1
• Pollution Degree 2 Category under IEC 61010-1

Laser Safety
The provisions contained in two standards define the safety procedures to be observed 
both by users and by manufacturers when utilizing laser products:

• IEC 60825-1:2014 – Safety of laser products – Part 1: Classification and 
requirements

Class A Equipment (Industrial Broadcasting & Com-
munications Equipment This equipment is Industrial (Class A) 

electromagnetic wave suitability equipment and 
seller or user should take notice of it, and this 
equipment is to be used in the places except for 
home.
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• FDA 21 CFR § 1040.10 – Performance standards for light-emitting products - 
Laser products.

Due to the range of possible wavelengths, power values, and injection characteristics 
of a laser beam, the risks inherent in its usage vary. The laser classes form groups 
representing different safety thresholds.

Laser classes
Standards IEC 60825-1:2014 and FDA 21 CFR § 1040.10:

• VFL option: Class 2
• OTDR modules: Class 1, Class 1M
• All plug-in fiber optic transceiver modules: Class 1

Warning labels for the laser classes
Due to the reduced dimensions of the optical modules, it is not possible to attach the 
required warning labels to them. In line with the provisions of Article 7.1 of the IEC 
60825-1 standard, the laser class identification labels are shown below:

Reference 
standard IEC 60825-1 FDA 21 CFR § 1040.10

Class 1

Class 1M

Class 2
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The user must take the necessary precautions concerning the optical output of the 
instrument and follow the manufacturer’s instructions.

Additional safety information
Safety information is provided in the document Safety Instructions - ONA-800  Base 
Unit, 22137678, which is shipped with the ONA-800.



Regulatory compliance
Additional safety information

ONA-800 Getting Started Guide
Page xii 22142812, R016 August 2023



ONA-800 Getting Started Guide
August 2023 22142812, R016 Page xiii

About this Guide

This section explains how to use this Getting Started Guide.

• “Purpose and scope” on page xiv
• “Assumptions” on page xiv
• “Conventions” on page xiv
• “Technical assistance” on page xvi
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Purpose and scope
The purpose of this manual is to help you successfully use the features and capabilities 
of the ONA-800 . This manual includes task-based instructions that describe how to 
configure, use, and troubleshoot the general functions of the base unit.

Assumptions
This manual is intended for novice, intermediate, and experienced users who want to 
use the test instrument effectively and efficiently. VIAVI assumes that you have basic 
computer experience and are familiar with basic telecommunication concepts, 
terminology, and safety.

Conventions
This guide uses typographical and symbols conventions as described in the following 
tables.

Table 1 Text formatting and other typographical conventions

Item(s) Example(s)

Buttons, keys, or switches that you 
press or flip on a physical device.

Press the On button.
– Press the Enter key.
– Flip the Power switch to the on position.

Buttons, links, menus, menu 
options, tabs, or fields on a PC-
based or Web-based user inter-
face that you click, select, or type 
information into.

Press the On button.
– Click File > Properties.
– Click the Properties tab.
– Type the name of the probe in the Probe Name 

field.

Directory names, file names, and 
code and output messages that 
appear in a command line interface 
or in some graphical user interfaces 
(GUIs).

$NANGT_DATA_DIR/results (directory)
– test_products/users/defaultUser.xml 

(file name)
– All results okay. (output message)

Text you must type exactly as 
shown into a command line inter-
face, text file, or a GUI text field.

– Restart the applications on the server using the 
following command:
$BASEDIR/startup/npiu_init restart

Type: a:\set.exe in the dialog box.

Command line option separators. platform [a|b|e] 

Optional arguments (text variables 
in code).

login [platform name] 

Required arguments (text variables 
in code).

<password>
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Table 2 Symbol conventions

This symbol indicates a note that includes important supplemental information or 
tips related to the main text.

This symbol represents a general hazard. It may be associated with either a DAN-
GER, WARNING, CAUTION, or ALERT message. See Table 3 for more informa-
tion.
This symbol represents an alert. It indicates that there is an action that must be per-
formed in order to protect equipment and data or to avoid software damage and 
service interruption.

This symbol represents hazardous voltages. It may be associated with either a 
DANGER, WARNING, CAUTION, or ALERT message. See Table 3 for more infor-
mation.
This symbol represents a risk of explosion. It may be associated with either a DAN-
GER, WARNING, CAUTION or ALERT message. See Table 3 for more information.

This symbol represents a risk of a hot surface. It may be associated with either a 
DANGER, WARNING, CAUTION, or ALERT message. See Table 3 for more infor-
mation.
This symbol represents a risk associated with fiber optic lasers. It may be associ-
ated with either a DANGER, WARNING, CAUTION or ALERT message. See 
Table 3 for more information.
This symbol, located on the equipment, battery, or the packaging indicates that 
the equipment or battery must not be disposed of in a land-fill site or as municipal 
waste, and should be disposed of according to your national regulations.

Table 3 Safety definitions

Term Definition

DANGER Indicates a potentially hazardous situation that, if not avoided, will result 
in death or serious injury. It may be associated with either a general haz-
ard, high voltage, or other symbol. See Table 2 for more information.

WARNING Indicates a potentially hazardous situation that, if not avoided, could 
result in death or serious injury. It may be associated with either a gen-
eral hazard, high voltage, or other symbol. See Table 2 for more informa-
tion.

CAUTION Indicates a potentially hazardous situation that, if not avoided, could 
result in minor or moderate injury and/or damage to equipment.
It may be associated with either a general hazard, high voltage, or risk of 
explosion symbol. See Table 2 for more information.
When applied to software actions, indicates a situation that, if not 
avoided, could result in loss of data or a disruption of software operation.

ALERT Indicates that there is an action that must be performed in order to pro-
tect equipment and data or to avoid software damage and service inter-
ruption.
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 The user must take the necessary precautions concerning the optical output of the 
instrument and follow the manufacturer’s instructions.

Technical assistance
For technical assistance, call the VIAVI Technical Assistance Center (TAC) at 1-844-
GO-VIAVI. For the latest TAC information, go to http://www.viavisolutions.com/en/
services-and-support/support/technical-assistance. 

http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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Chapter 1Getting started 

This chapter explains how to use this Getting Started Guide.

The topics discussed in this chapter are as follows:

• “About the ONA-800” on page 2
• “Unpacking and inspection” on page 3
• “ONA-800 base” on page 3
• “Additional Modules” on page 5
• “Attaching the screen” on page 6
• “Attaching modules” on page 7
• “Powering the base unit” on page 12
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About the ONA-800
The ONA-800 is a modular communications test and measurement instrument that may 
be used both indoors and outdoors. Modules with specific test capabilities can be 
added and removed as required. The unit features an 8-inch touchscreen for quick 
access to the touch-based user interface. Powered by either external AC power or 
batteries in the field, the ONA-800 is both rugged and portable. Capabilities such as 
WiFi and Bluetooth are optional.

Figure 1 shows the front panel touchscreen.

Figure 1 Front panel touchscreen

The ONA-800 base is available in two variants. Table 1 describes the ONA-800 base 
variants.

WARNING
The equipment is not intended to be used outdoors during unattended 
operation, in inclement weather, or using the supplied AC/DC adapter.

Table 1 ONA-800 base variants

Variant Features

ONA-800A-MF – Modularity; dual-bay, detachable or plug-in (via Fiber Module 
Carrier) capability

ONA-800A-MF2 – Modularity; dual-bay, detachable or plug-in (via Fiber Module 
Carrier) capability

– Support for Power Expansion Module (PEM)

ONA-800A-MF2-T – Modularity; dual-bay, detachable or plug-in (via Fiber Module 
Carrier) capability

– Support for Power Expansion Module (PEM)
– For transport configurations

ONA-800A-MF2-F – Modularity; dual-bay, detachable or plug-in (via Fiber Module 
Carrier) capability

– Support for Power Expansion Module (PEM)
– For fiber configurations
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Unpacking and inspection
VIAVI typically ships our instruments using anti-static packing material to stabilize the 
components inside the box. When unpacking the components, verify that all the items 
you ordered are included in the package. Accessories may be shipped in a separate 
box.

After you unpack the components, examine the top, bottom, front, and side panels, 
including ports, LEDs, and the touchscreen for damage.

If any component shows signs of damage, contact VIAVI Customer Care at 1-844-GO-
VIAVI. For the latest TAC information, go to http://www.viavisolutions.com/en/services-
and-support/support/technical-assistance. For information about returning equipment, 
see “Returning equipment to VIAVI”.

Consider saving shipping boxes and packing materials in case you need to repackage 
the components for shipment. 

Base unit contents
The ONA-800 base unit consists of the following equipment:

• One field-replaceable Lithium Ion battery:
– C5BATTERY98 or 
– BAT-96WHR for Transport applications

• AC adapter and cord:
– G700050127 or
– PS-330W24V for Transport applications

• A back cover or up to two dummy modules, depending on the number of solution 
modules ordered 

• LCD screen protector

ONA-800 base
Figure 2 shows the top panel of the ONA-800 base.

ONA-800A-MF2G-T – Modularity; dual-bay, detachable or plug-in (via Fiber Module 
Carrier) capability

– Support for Power Expansion Module (PEM)
– No Bluetooth® 
– No WiFi
– For transport configurations

Table 1 ONA-800 base variants

Variant Features

http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance


Chapter 1 Getting started
ONA-800 base

ONA-800 Getting Started Guide
Page 4 22142812, R016 August 2023

Figure 2 ONA-800 base top panel

Figure 3 shows the left and right side panels.

Figure 3 Left and right side panels

Figure 4 shows the back panel without the backplate or modules attached.

1 AC/DC power adapter port (19-27 V, 15A Max)
2 Power button
3 LAN port (use shield cable)
4 USB port
5 USB port
6 USB-C port (device only)
7 Micro SD card port
8 Optional module slot

1 Cooling fans
2 Battery access door
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Figure 4 Back panel, no modules or backplate

Additional Modules
You can add additional modules to the ONA-800 base.

Full-sized modules
Refer to the user documentation that came with your module for information about the 
features, capabilities, and operation of your specific Solution or Fiber Module Carrier 
modules.

PEM

The ONA-800A-MF2 supports the addition of the ONA-MF2-PEM Power Expansion 
Module (PEM), allowing you to add additional batteries to the ONA-800 for an extended 
battery runtime. You can attach up to two PEMs, providing the ONA-800 with 3 
batteries (2 external/1 internal) for a total of 244Wh.

Figure 5 shows the PEM.

1 Screws
2 ESD ground
3 Module connector ports
4 Hex key

NOTE
The PEM is only supported on the ONA-800A-MF2.
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Figure 5 PEM bottom and back views  

Charging the PEM

You can charge the PEM:

• On its own using the charger input, using the same adapter that ships with the 
ONA-800.

• When connected to the ONA-800.

Hot Swapping of PEM

If you are using a PEM, you must perform the initial installation of the PEM in either of 
the two slots on the back of the ONA-800A-MF2 before turning on or rebooting the unit. 
Once the unit is on, you can hot swap to another PEM in the same physical slot. When 
using two PEMs, both must be initially installed with the ONA-800A-MF2 unit powered 
off.

With additional fully charged PEMs, you can continuously extend the battery operation 
for a long period of time.

Attaching components
The following sections describe how to install components to the ONA-800 base.

Attaching the screen
The following procedure describes how to attach the screen to the ONA-800 base unit.

1 Fan
2 Charger input panel
3 State of Charge (SOC) LEDs
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To attach the screen to the base unit

1 Set the screen onto the base, ensuring the mating connectors between the two 
pieces are aligned, as shown in Figure 6.

Figure 6 Set screen to base

2 Set unit so you have access to the back. Using the Hex Key located in the 
groove on the back panel of the screen, tighten the four fasteners, as 
shown in Figure 7.

Figure 7 Fastener locations

Attaching modules
This section describes how to attach modules to the ONA-800.
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Solution and Fiber Module Carrier modules

Table 2 lists the Solution modules you can attach to the ONA-800 base.

The following procedure describes how to attach a Solution or Fiber Module Carrier 
module to the ONA-800.

To attach a Fiber Module carrier or Solution module

1 Power down the ONA-800 and disconnect from AC power.

2 Place the unit so that you have access to the back and remove the termination 
cover by removing the screws that hold it in place.

3 Set the module onto the screen, ensuring the mating connectors between the two 
pieces are aligned, as shown in Figure 8.

Figure 8 Module to screen

4 Insert the hex key in the brass fittings on the rear of the module and tighten the 
internal captive fasteners to secure the module to the display.

Table 2 Solution Modules

Module Description

SPA06MA Spectrum Analyzer with 6 GHz RF and 25 Gbps Optical hardware. 

SPA06MA-O Spectrum  Analyzer with 6 GHz RF.

RA44MA-O Radio Analysis Module (44 GHz)

RA18MA-O Radio Analysis Module (18 GHz)

E81FMC1 Fiber Module Carrier module that allows you to install Fiber 
Modules. See Table 4 on page 10 for a list of supported Fiber 
Modules.

TM400GB-QO 400G Module for ONA 800 with one QSFP-DD port and one
OSFP port.

TM400GB-QQ 400G Module for ONA 800 with two QSFP-DD ports.
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5 Place the ONA-800 base onto the module, ensuring the mating connectors are 
aligned, as shown in Figure 9.

Figure 9 ONA-800 base to module

6 Using the hex key, tighten the captive fasteners on the rear of the base that 
secure it to the module.

7 Re-attach the expansion modules or back cover.

Expansion modules

You can attach the following expansion modules to the ONA-800:

Table 3 lists the expansion modules you can attach to the ONA-800 base.

The following procedure describes how to attach expansion modules to the ONA-800.

To attach expansion modules

1 Power down the ONA-800 and disconnect from AC power.

2 Place the unit so that you have access to the back and remove the termination 
cover by removing the screws that hold it in place.

Table 3 Expansion modules

Module Description

CAA Provides cable and antenna analysis

OTDR and MPO Switch Optical Time-domain Reflectometer and Multi-
Fiber Switch

OSA/OCV/OCC Optical Spectrum Analyzer/Optical Channel 
Verifier/Optical Channel Checker 

TEM Timing Expansion Module

PEM (ONA-800A-MF2 only) Power Expansion Module
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3 Locate the hinges on the module and insert them into the base at a 45 to 60 
degree angle

4 Pivot the module down towards the connector, as shown in Figure 10.

Figure 10 Pivot module down

5 Seat the module into the connector with slight pressure.

6 Tighten the screws on the module.

The following procedure describes how to remove CAA/OTDR modules.

To remove expansion modules

1 Power down the ONA-800 and disconnect from AC power.

2 Place the unit so that you have access to the back.

3 Remove the screws on the module.

4 Remove the module from the ONA-800.

Plug-in modules

Table 4 lists the plug-in modules supported on the ONA-800.

NOTE
The Fiber Module Carrier module must be installed before you can install plug-in 
modules. See “To attach a Fiber Module carrier or Solution module” on page 8 for 
more information.

Table 4 Supported plug-in modules

Catalog Number Description

OSA modules

2304-8491.027 OSA-110M PC



Chapter 1 Getting started
Attaching components

ONA-800 Getting Started Guide
August 2023 22142812, R016 Page 11

2304-8491.030 OSA-110H, Compact, High Power, PC

2304-8491.137 OSA-110H, Compact, High Power, APC

2304-8491.043 OSA-110R PC Compact with In-Band OSNR

2304-8491.140 OSA-110R APC Compact with In-Band OSNR

EOSA610B-APC HIGH RESOLUTION OSA MODULE VERSION B

EOSA610B-APCFC HIGH RESOLUTION OSA MODULE VERSION B

EOSA610B-PC HIGH RESOLUTION OSA MODULE VERSION B

OTDR modules

E8123AV-PC High Resolution OTDR Module AV 850/1300nm PC connector - 
SC adapter Std

E8146A-PC OTDR Module A EF-850/1300nm and 1310/1550nm PC connector 
- SC adapter Std

E8156A-PC OTDR Mod. A EF-850/1300nm and 1310/1550/1625nm PC conn. 
- SC adapter Std

E8126C-APC OTDR Module C 1310/1550nm APC connector - SC adapter Std

E8126C-PC OTDR Module C 1310/1550nm PC connector - SC adapter Std

E8136C-APC OTDR Module C 1310/1550/1625nm APC connector - SC adapter 
Std

E8136C-PC OTDR Module C 1310/1550/1625nm PC connector - SC adapter 
Std

E8126D-APC OTDR Module D 1310/1550nm APC connector - SC adapter Std

E8126D-PC OTDR Module D 1310/1550nm PC connector - SC adapter Std

E8129D-62-APC OTDR Module D 1550/Filtered 1625nm APC connector - SC 
adapter Std

E8129D-62-PC OTDR Module D 1550/Filtered 1625nm PC connector - SC 
adapter Std

E8136D-APC OTDR Module D 1310/1550/1625nm APC connector - SC adapter 
Std

E8136D-PC OTDR Module D 1310/1550/1625nm PC connector - SC adapter 
Std

DTS modules

EDFOS-DTS-SM Single Mode Raman OTDR module

ODM modules

E81MRODM2-APC Medium range Optical Dispersion Measurement module with APC 
connector

Table 4 Supported plug-in modules

Catalog Number Description
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The following procedure describes how to install a plug-in module into the Fiber Module 
Carrier attached to the ONA-800.

To install a plug-in module

1 Power down the ONA-800 and disconnect from AC power.

2 If you have not already done so, install the Fiber Module Carrier module, as 
described in “To attach a Fiber Module carrier or Solution module” on page 8.

3 Slide the plug-in module into the Fiber Module Carrier module, as shown in 
Figure 11.

Figure 11 Insert plug-in module

4 Tighten the thumb screws.

Powering the base unit
Power is supplied to the instrument by the battery or the AC power adapter. For the 
ONA-800, the adapter is supplied with the instrument. Use of AC power adapters or 
batteries other than those supplied with your ONA-800 is not recommended as other 
slices/modules may be supplied with incompatible adapters or batteries. When 

E81MRODM2-PC Medium range Optical Dispersion Measurement module with PC 
connector

E81LRODM2-APC Long range Optical Dispersion Measurement module with APC 
connector

E81LRODM2-PC Long range Optical Dispersion Measurement module with APC 
connector

Table 4 Supported plug-in modules

Catalog Number Description
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supplying power using the AC power adapter, you need to verify that you have the 
correct adapter.

Battery Installation
The base unit can operate supplied by the AC power adapter shipped with the unit or 
by battery. Figure 12 and Figure 13 show the battery labels.

Figure 12 ONA-800 battery label

Figure 13 ONA-800 Battery label (for transport)

CAUTION:
Do not attempt to run the ONA-800 in an enclosure such as the soft-shell travel 
case. Doing so may damage the unit.

CAUTION:
The Lithium Ion batteries shipped with the unit can explode if incorrectly 
installed. When replacing the battery, ensure that you only use VIAVI approved 
battery types, as shown in Figure 7, and that they are properly installed. Always 
dispose of batteries according to your local safety and environmental 
regulations.

NOTE:
VIAVI recommends that you either power off the unit or switch to AC power 
before replacing the batteries.
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To install the battery 

AC power adapter
The base unit with all applications installed operates from 19-27V DC and can operate 
supplied by the 19V DC, 160W AC, or 24V DC 330W AC power adapter shipped with 
the unit. The nominal input ratings of the power adapter are 100-240V AC, 50-60Hz, 
and it auto-ranges between 90-264V AC and 47-63Hz. The mains supply cord used 
with the power adapter must be grounded with a connection to protective earth.

1 Battery access door
2 Field-replaceable Lithium Ion battery

NOTE:
Before connecting an AC power adapter to the base unit, refer to the label on the 
adapter (Figure 15) to confirm that it is the correct adapter for use with the unit. AC 
power adapters supplied with modules might not be compatible for use with the ONA-
800.
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Figure 14 ONA-800 AC power adapter label 

Figure 15 ONA-800 AC power adapter label (Transport)
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2

Chapter 2Setting up the system

This chapter covers the following information:

• “Home Screen” on page 18 
• “Favorites” on page 18
• “Setting up remote access” on page 25 
• “Connecting to a Wi-Fi network” on page 25 
• “Setting up a Bluetooth connection” on page 25
• “Setting up the GNSS” on page 26
• “Transferring files using FTP and SFTP” on page 29
• “Using Smart Access Anywhere” on page 29 
• “Enabling software options” on page 29 
• “Updating the system software” on page 30 
• “Job Manager” on page 33 
• “Synchronizing to the StrataSync server” on page 37
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Home Screen
When you first start the ONA-800, the Home Screen appears, as shown in Figure 16.

Figure 16 Home Screen

The Home screen provides access to the Tests, Job Manager, and System pages. 
You can return to the Home screen at any time by clicking the Home button in the top 
left corner of the screen. Figure 17 shows the Home button.

Figure 17 Home button

Favorites
The Favorites page provides access to test pages identified as Favorites and the most 
recently visited test pages. Figure 18 shows the Favorites page.
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Figure 18 Favorites

Editing Favorites

You can add, edit, and remove items from Favorites. The following procedures describe 
how to add, edit, and remove items.

To add an item to Favorites from the Favorites page

1 Open the Favorite page by pressing Home, then pressing Favorites.

2 Press the Edit favorites list button. 
The items in Favorites are outlined in purple, signifying they are now able to be 
edited.

3 Click and hold, then drag the test from Recent to Favorites, as shown in 
Figure 19.
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Figure 19 Drag and drop

To add an item to Favorites from a test page

1 On the test page you want to add, select the Save button from the side menu, as 
shown in Figure 20.

Figure 20 Save button

The Save screen appears.

2 Click the Create Favorite tab.
The Create Favorite screen appears.

3 Press the Create button.
The item will appear on the Favorites page.

NOTE
This procedure is only available on certain solution modules. 
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To edit an item in Favorites

1 Open the Favorite page by pressing Home, then pressing Favorites.

2 Press the Edit favorites list button. 
The items in Favorites are outlined in purple, signifying they are now able to be 
edited.

3 Click the item you want to edit to select it. The icon is darkened, as shown in 
Figure 21.

Figure 21 Item selected

4  Double-click the selected icon to enter into Edit mode, as shown in Figure 22.

Figure 22 Edit mode 

5 Edit the item:

a To change the name, click the item’s name and enter a new one using the 
on-screen keyboard.

b To change the icon:

i Click the icon. The Load Icon window appears.

ii Select the new icon, then press the Load Icon button.
The item’s icon has been changed.

To remove an item from Favorites

1 Open the Favorite page by pressing Home, then pressing Favorites.

2 Press the Edit favorites list button. 

3 The items in Favorites are outlined in purple, signifying they are now able to be 
edited.

4 Click the item you want to edit to select it. The icon is darkened, as shown in 
Figure 23.
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Figure 23 Item selected

5  Double-click the selected icon to enter into Edit mode, as shown in Figure 24.

Figure 24 Edit mode 

6 Click the X in the top right corner of the item.

To set auto launch preference

You can launch the measurement mode you were last operating.

1 Open the Favorite page by pressing Home, then pressing Favorites.

2 Press the Auto launch preferences button.

3 Press Last running state in the list. 

Tests
The Tests page provides access to the available tests. 
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Figure 25 Tests page

Job Manager
The Job Manager allows you to specify the information to be included whenever you
run a test and generate a report. Each time you generate a report, your instrument will
automatically insert the Customer Name, Job Number, Technician ID, and Test 
Location that you specified in the Job Manager into the report heading.

See “Job Manager” on page 33 for more information.

System
The System screen provides access to tools for viewing system information and 
performing other tasks as required. 

NOTE
Additional tools might be available on the System screen when optional software features are 
installed. 
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Figure 26 System screen

The tool bar also provides access to certain system tools, including and power 
management.

Table 5 System tools

Tool Description

Files Access files saved to the unit.

Removable Storage Access the USB plugged into the unit.

Network Configure Ethernet connectivity and, optionally, Wi-Fi connectivity.

Power Management View power supply information and manage power settings.

Date and Time Specify date and time settings.

Region Specify international settings, including the language of the user 
interface.

Display Adjust the brightness level of the touchscreen, enable the screen 
saver, and, when required, calibrate the touchscreen display. 

Remote View and manage remote access settings, including, when 
required, VNC and Smart Access Anywhere settings.

Upgrade Perform system software updates.

Test Set Lock Manage lock options that prevent unauthorized access to the unit.

Audio Manage speaker and microphone volume settings.

Clock Source Set up a reference frequency and timing source.

System Info View and manage system information.

StrataSync Connect to the StrataSync server for synchronization.

Video Player Access the video player on the unit.
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Setting up remote access
1 Select System on the menu bar, and then select Remote.

2 Type a password in the Remote access password field.
This password applies to all remote-access tools; for example, VNC, FTP, and 
SSH.

3 Optionally, do any of the following:
– Enable or disable VNC access by selecting or deselecting, respectively, the 

Enable VNC access check box.
– Enable or disable a password for VNC by selecting or deselecting, 

respectively, the Require password for VNC access check box.

Connecting to a Wi-Fi network

1 Select System on the menu bar, and then select Network.

2 Select Wi-Fi, and then select the Enable Wireless Adapter check box to display 
a list of available wireless networks.

3 Select a network, and then enter the access credentials.

Setting up a Bluetooth connection

1 Select System on the menu bar, and then select Bluetooth.

2 Enable the following check boxes:
– Enable Bluetooth 
– Allow other devices to pair with this device 

Web Browser Access the World Wide Web.

Job Manager Specify the information to be included whenever you run a test 
and generate a report.

Table 5 System tools (Continued)

Tool Description

NOTE
Wi-Fi connectivity is optionally available. Contact your VIAVI sales representative for more 
information.

NOTE
Bluetooth connectivity is an option that must be available on the unit before this procedure can 
be performed. Contact your VIAVI sales representative for more information.
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3 Optionally, enter a name for the unit.

4 Activate Bluetooth on the remote device to be paired with the unit.

5 On the unit, select Start Scanning to locate detectable devices in range.
The names of newly detected devices appear in the Discovered Devices, and 
the names of previously detected devices appear in the Paired Devices list.

6 Select the remote device.

7 On the remote device, enter a pairing code if prompted, and then select Pair to 
pair it with the unit.

Setting up the GNSS

If your device is licensed to do so, you can configure the GNSS setting by clicking the 
GNSS icon on the System screen. You are required to configure GNSS settings of you 
need the GNSS location or need to use it as a frequency and clock source.

To turn on GNSS

• Select the System icon, then select GNSS.

Specifying GNSS settings
You can configure the GPS settings depending on what is needed, however turning 
GNSS and Antenna Power on should make it work in most cases.

To specify GNSS settings

1 In GNSS, turn on Antenna Power if required. The antenna power setting enables 
the external antenna power, depending on what you have plugged into the instru-
ment. If you have an externally powered antenna, you do not need to turn on the 
antenna power.

2 Select the required Fix Type:
– 2d Mode: A 2D (two dimensional) position fix that includes only horizontal 

coordinates. This mode requires a minimum of three visible satellites.
– 3D Mode: A 3D (three dimensional) position fix that includes horizontal 

coordinates. This mode requires a minimum of four visible satellites.
– Any: Calculates a 3D position if possible, but reverts to 2D position if 

necessary.
3 Turn the GNSS value to On if using GNSS.

NOTE
GNSS is an option that must be available on the unit before this procedure can be performed. 
Contact your VIAVI sales representative for more information.
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4 Select the GNSS System supported in the region where you intend to conduct 
testing. If using a Satellite Based Augmentation System (SBAS) to augment the 
GNSS system, select the potion that provides SBAS (indicated with +SBAS).

5 Select the desired Survey Mode from the following choices:
– Dynamic: Continuously calculates positioning for continuous location 

information
– Auto: Calculates positioning until accurate location information is determined 

and switches to fixed position using accurate location information, and 
switches to determine timing accuracy

6 In Elevation Limit (deg), specify the elevation limit in degrees. This value 
represents the lowest point on the horizon on which the receiver will try to locate 
and obtain information from GNSS satellites. The default elevation is set to 10 
degrees. Using satellites near the horizon may degrade performance.

7 In Minimum C/No (dBHz), specify the minimum Carrier to Noise Ratio (C/ No) for 
the satellite signals that will be used by the module’s GNSS receiver. The C/No is 
an indication of signal strength ranging from 0 to 50 dBHz. The default value is 9 
dBHz. Using satellites with a weak C/No may degrade performance.

8 Specify the Antenna Time Bias value. The default Antenna Time Bias value is 28 
(the optimal value for the VIAVI qualified antenna). If you are using a different 
antenna, determine the optimal bias value by referring to the vendor specifica-
tions for the antenna (and, if applicable, splitter or amplifier), then specify the bias 
value in nanoseconds. This value represents the bias that is used to compensate 
for the delay introduced by your antenna, the antenna’s cable, and if applicable, 
an inline splitter or amplifier where absolute accuracy of PPS is important.

Sky Plot
The Sky Plot illustrates the satellites that were identified using the GNSS receiver 
attached to the instrument. The ID is provided for each satellite, and colors are used to 
indicate the satellite’s status (No Signal, Signal, Ready, or Used). Figure 27 shows the 
Sky Plot.
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Figure 27 Sky Plot

Table 6 describes each color used to communicate the satellite status.

Signal strength
The signal strength for each received channel for used satellites is illustrated in the 
signal strength category, and represents the Carrier to Noise Ratio (C/No or CNO) on 

Table 6 Satellite status

Color Status Indicates

Red No Signal A signal from the satellite is not avail-
able, but the satellite’s presence is 
known based on information provided in 
the Almanac (and broadcast by other 
satellites within the constellation).

Dark Blue Signal The signal from the satellite has been 
acquired and the GNSS receiver is 
receiving data. 

Light Blue Ready The GNSS receiver is receiving position 
information
from the satellite, but the information is 
unusable
because the satellite is:
– below the Elevation Limit (specified 

as a GNSS configuration setting)
– less than the Minimum C/No (speci-

fied as a GNSS configuration set-
ting)

– offline

Green Used The signal from the satellite is being 
used to provide GNSS timing.
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a scale of 0-50, with 50 representing the optimal signal strength. Each bar is color 
coded to communicate the satellite’s status per descriptions provided in Table 6.

Transferring files using FTP and SFTP
You can transfer files to and from the ONA-800 using File Transfer Protocol (FTP) or 
Secure File Transfer Protocol (SFTP). Connect using an FTP or SFTP client with the 
following credentials:

• Account ID: advisor
• Password (default): VIAVI

Using Smart Access Anywhere
Smart Access Anywhere allows you to view and control the instrument’s user interface 
from a remote location using a workstation. In addition to configuring the instrument and 
performing tests, you can transfer files to and from the instrument using the 
instrument’s file manager utility. You can also rename and delete files, or create, 
rename, and delete directories.

See “Using Smart Access Anywhere” on page 13 for more information.

Enabling software options
Software options may be available on the unit or purchased separately. For information 
about purchasing software options, contact the VIAVI Solutions Sales Office for your 
region.

Viewing available software options
To view available software options, select System on the menu bar, and then select 
System Info. Available options are listed in the Base Options pane. An icon indicates 
the status of each option.

Table 7 Software Option Status Icons

Icon Status

Option is enabled.

Free-trial period for an option is expiring. When the trial period ends, a warning 
message appears. If a test is running when the trial period ends, the test will 
continue, but an expiration warning appears continuously until a license code 
is entered or a reset is performed.
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Enabling purchased software options

1 Select System on the menu bar, and then select System Info.

2 Connect the USB stick to a USB port on top panel of the unit.

3 Select Import Options from USB below the Base Options pane.
A confirmation message appears when the options are installed.

4 Restart the instrument, access the System Info tool, and then confirm that each 
software option appears in the Base Options pane and is enabled (Table 7 on 
page 29).

Updating the system software
System software and solution firmware can be updated from storage media, such as a 
USB drive, or over the network.

This section describes the following tasks:

• “Updating the system software using a USB drive” on page 30
• “Updating the system software over the network” on page 32

Updating the system software using a USB drive
Download the system software to a PC and then extract it to a USB drive with at least 
1 GB available space. VIAVI recommends that the USB drive have no other content 
stored on it.

The update process when using a USB drive involves the following procedures:

• “Downloading the software and extracting to a USB drive” on page 31
• “Performing a software update using a USB drive” on page 31

Option is not enabled. Contact the VIAVI Solutions Sales Office for the region 
for information about enabling it.

Table 7 Software Option Status Icons

Icon Status

IMPORTANT
Before beginning this procedure, ensure that the USB stick on which software option files are 
saved is available.
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Downloading the software and extracting to a USB drive
1 Using a Web browser on a personal computer (PC), go to VIAVI Software 

Updates and Downloads.

2 Locate and then click the link for the latest version of the self-extracting system 
software file for the unit.

3 Save the software file to a location on the PC.

4 Plug a USB drive into the PC.

5 Using Windows Explorer, navigate to the software file, double-click the file, and 
then click Run.

6 In the dialog that appears, click Browse to navigate to and select the USB drive.

7 Click Extract to initiate extraction of the system software files to the USB drive. 
Do not unplug the drive from the PC while the files are extracting.

8 When all the files are extracted, navigate to the USB drive, right-click the name of 
the drive, and then click Eject.

9 Unplug the USB drive from the PC.

10 If required, go to “Performing a software update using a USB drive”.

Performing a software update using a USB drive
1 Confirm the following:

– The unit will have an uninterrupted supply of power during the software 
update. If necessary, connect the AC power adapter to the unit.

– A USB drive on which the extracted system software files are saved is 
available.

2 Plug the USB drive into the USB connector on the top panel of the unit.

3 Select System on the menu bar, select Upgrade, and then select USB.
The release number of the software available on the USB drive appears. Note the 
following symbols that may appear beside the release number on the USB stick:
– An equals symbol indicates that the software on the USB stick and the 

software on installed on the unit are the same (that is, have the same release 
number).

– A down-arrow symbol indicates that the software on the USB stick is an 
earlier release than the software installed on the unit.

– An up-arrow symbol indicates that the software on the USB stick is a later 
release than the software installed on the unit and the system software can 
be upgraded to the later release.

4 To upgrade to a later release, select Start Upgrade.

WARNING:
Electrical shock may result in serious injury or death. Be sure the AC power adapter 
is connected to the correct voltage mains. Do not use the adapter outdoors or in wet 
locations. Use only the AC power adapter supplied with the unit.

https://www.viavisolutions.com/en-us/support/software-downloads-and-updates#Group-C
https://www.viavisolutions.com/en-us/support/software-downloads-and-updates#Group-C
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A dialog box appears with prompts to either exit all tests that are running or cancel 
the update if the tests cannot be stopped.

5 Select OK to proceed with the software update. Do not unplug the USB drive from 
the unit during the update. 
The unit automatically restarts when the update is completed. 

6 After the unit has restarted, unplug the USB drive.

Updating the system software over the network
The system software on the unit can be updated over a network connection to a server 
where the updated software file is located, such as ona-800.updatemyunit.net. Before 
beginning the update, review the following recommendations:

• Use a wired network connection.
• A unit that is behind a firewall might not be able to access the server where the 

system software is located. Connect the unit over a public network instead.

1 Ensure that the unit will have an uninterrupted supply of power during the update. 
If necessary, connect the AC power adapter to the unit.

2 Select System on the menu bar, select Upgrade, and then select Network. 

3 Do one of the following: 

a Enter the server address where the update is located.

b Enter the address where the software file is located; for example, the FTP 
address, server IP address or host name, and the proxy server address (if 
necessary), as well as the access credentials. 

4 Select Connect. 

5 After the unit accesses the server, select the link for the software file for the unit.
Note the following symbols that may appear beside the release number of the 
software file:
– An equals symbol indicates that the software on the USB stick and the 

software on installed on the unit are the same (that is, have the same release 
number).

– A down-arrow symbol indicates that the software on the USB stick is an 
earlier release than the software installed on the unit.

– An up-arrow symbol indicates that the software on the USB stick is a later 
release than the software installed on the unit and the system software can 
be upgraded to the later release.

6 Select Start Upgrade. 

WARNING:
Electrical shock may result in serious injury or death. Be sure the AC power adapter 
is connected to the correct voltage mains. Do not use the adapter outdoors or in wet 
locations. Use only the AC power adapter supplied with the unit.

http:\\ona-800.updatemyunit.net
http:\\ona-800.updatemyunit.net
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A dialog box appears with prompts to either exit all tests that are running or cancel 
the update if the tests cannot be stopped.

7 Select OK to begin the software update.
The unit automatically restarts when the update is completed.

Job Manager
The Job Manager provides Test Process Automation, including Technician Guidance. 
A Step-by-step walk-through of the testing tasks associated with the job includes being 
able to launch the job or review a job guide for a specific task. When all tasks are 
completed, the technician is notified and prompted to return to the Job Manager.

Generated reports automatically insert the Customer Name, Job Number, Technician 
ID, and Test Location that you specified into the report heading. 

Test plans
The Test Plan section provides a list of planned test items associated with a job, 
including the test type to be performed, reference information, and the pass/fail status. 

Creating test plans

The following procedure describes how to create a test plan using the on-line tool.

To create a test plan

1 Using a browser on a PC or laptop, log in to https://
jobmanager.stratasync.viavisolutions.com/. 

2 In the Job Information section, enter the:
– Job Number
– Customer
– Location (A)
– Technician ID
– Report Logo File (optional)

NOTE
The software update can take several minutes, depending on the speed and reliability of the 
network.

NOTE:
The Job Number specified in the Job Manager will be provided as the default Work 
Order Number when applicable to specific reports.

https://jobmanager.stratasync.viavisolutions.com/
https://jobmanager.stratasync.viavisolutions.com/
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3 In the Test Plan section, add tests to the test plan.

a In Select a test type, select a test type from the drop-down list.

b In Info, enter information about the test.

4 If applicable, enter the file name of a configuration file to automatically load for the 
test. This file should already be on the instrument.

5 Click Save.

6 Add the test plans to the instrument using StrataSync. See “Synchronizing to the 
StrataSync server” on page 37 for more information.

Running jobs
The following procedures describe how to run jobs.

To run a job

1 Tap Job Manager in the left hand menu.
The Job Manager screen appears, listing the jobs loaded onto the device, as 
shown in Figure 28.

Figure 28 Job Manager screen

2 Select the Job you want to run by tapping Set as Current. The Job moves to the 
top of the list, expanded to show the test plan, as shown in Figure 29.
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Figure 29 Current Job

3 Press the  button for each test you want to run. 
When the Job is complete, you can create a report. 

The following procedure describes how to create a Job report.

To create a Job report.

1 Press the Details button. The Job Details screen appears, as shown in 
Figure 30.

Figure 30 Job Details screen

2 Tap the Create Report button. The Create Report screen appears, as shown in 
Figure 31.
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Figure 31 Create Report screen

Freeform jobs

You can use the Job Manager to create an empty Freeform job that allows you to run 
ad-hoc tests and record the results in a consolidated report. The following procedure 
describes how to use an empty job.

To create and use empty jobs

1 Tap Job Manager in the left hand menu.
The Job Manager screen appears.

2 At the bottom of the screen, tap New.

3 The Create Job window appears, as shown in Figure 32.

Figure 32 Create Job window

4 Enter a job number using the on-screen keyboard and tap Save. 



Chapter 2 Setting up the system
Synchronizing to the StrataSync server

ONA-800 Getting Started Guide
August 2023 22142812, R016 Page 37

5 Perform the tests you want, saving the results.

6 Return to the Job Manager. The tests you ran appear in the Optional Tests 
section.

7 Tap the Create Report button to create the consolidated report of the tests.

Synchronizing to the StrataSync server
To automatically obtain the latest configuration settings, software options, updates and 
ownership registration information, the unit should be synchronized with a VIAVI server 
via the Internet using an optional subscription-based service called StrataSync. 

In addition to the latest operating software, synchronization also uploads user files 
saved on the unit to the StrataSync server. A connection to the Internet would be 
provided upon receipt of the unit and on a regular (daily) basis thereafter to ensure that 
the most currently issued options and updates are available to the unit and to allow all 
user information to be backed up. 

The unit must be able to connect to the Internet over Ethernet or Wi-Fi. When an 
Internet connection is available and the unit is connected to the StrataSync server, a 
request to initiate the syncing process appears.

1 Select System on the menu bar, and then select StrataSync.

2 Verify that the server address appears in the Server Address field. The default 
server address is stratasync.viavisolutions.com.

3 Enter the ID of the unit in the Account ID field.
Synchronization cannot occur without the entry of a pre-approved, unique account 
ID obtained from VIAVI. Ensure that an account ID is available before attempting 
to access the StrataSync server.

4 Optionally, enter an ID in the Technician ID field.
A default technician ID is provided. This ID can be modified at any time.

5 Select Start Sync to initiate a connection to the StrataSync server.
Synchronization begins when a connection to the server is established.

NOTE
Ensure that network settings are configured on the unit via the Network system tool. VIAVI 
recommends setting the IP mode to DHCP. 

NOTE
During Synchronization, icons indicating the progress and either the failure or completion of the 
process are displayed. 
When an error or failure occurs, a message appears, detailing the possible issue.
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3

Chapter 3Powermeter and VFL

This chapter describes the Powermeter and VFL.

The topics discussed in this chapter are as follows:

• “Connection to the power meter and VFL” on page 40
• “Using the power meter” on page 40
• “Storing and reloading results” on page 48
• “VFL function” on page 49
• “Characteristics of the options” on page 50
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Connection to the power meter and VFL
The optical connector type used for the Powermeter and the VFL is UPP (Universal 
Push Pull), which is compatible with all 2.5 mm diameter connectors (FS, SC, DIN, 
E2000, etc.) 1.25 mm diameter connectors (LC) are supported with an adapter for the 
Powermeter.

Figure 33 shows the location of the Optical connectors on the ONA-800.

Figure 33 Optical connectors

Using the power meter
The power meter functions an option chosen at the time of order and incorporated into 
the ONA-800 platform in the factory.

To activate the function:

1 Press the HOME button.

2 Press the Tests button and then select Fiber 1 (ONA-PMVFL) >.

3 Press the Powermeter button of the Platform. Figure 34 shows the Powermeter 
button.

Figure 34 Powermeter button

Configuring the power meter

To access the configuration parameters of the Powermeter

1 Press the Setup softkey, as shown in Figure 35.

Figure 35 Setup softkey
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2 Select either:
– Measurement
– Alarms
– Link
– File
Figure 36 shows the configuration options.

Figure 36 Powermeter configuration

Configuring the Measurement parameters

In the Setup menu, select Measurement.

Table 8 describes the parameters.

Table 8 Measurement parameters

Parameter Description

Wavelength Select wavelength:
– Auto: The wavelength of the input signal will be automatically 

detected and selected to perform the measurement.
– Note: The source must also be in Auto mode
– 850, 980, 1300, 1310, 1420, 1450, 1480, 1490, 1510, 

1550,1578, 1625 or 1650 nm: Measurement performed at 
specified wavelength.

– User: Choice of wavelength on the next line.
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Configuring the alarm parameters

In the Setup menu, select Alarms.

Table 9 describes the Alarms parameters.

Configuring the Link parameters

In the Setup menu, select Link.

User choice Applicable if User option was selected in the Wavelength line.
Selection of the wavelength between 800 nm and 1650 nm, by 
clicking on Edit Value to use the numeric keypad to enter a wave-
length.

Beep on modula-
tion

Select to hear a sound when a modulation occurs. Options:
– Yes
– No

Unit Unit of power displayed:
– Watt, dBm: displays absolute power
– dB: displays a result relative to a reference (link loss.)

Reference Level If dB units were chosen as the Unit, specifes the reference value 
for the wavelength selected:
1. Select the wavelength.
2. Select the displayed reference level.
3. Enter the new Reference Level value.
4. Confirm the value by clicking the check mark button.
This reference is also automatically available in the Results page, 
using the Standard Ref soft button.

Attenuator com-
pensation

Choice of level to be applied to the wavelength chosen for the 
measurement to compensate for the loss due to the external atten-
uator (+XX.XX dB):
1. Select the wavelength.
2. Select the displayed value.
3. Enter the new Attenuator Compensation value.
4. Confirm the value by clicking the check mark button.

Table 8 Measurement parameters

Parameter Description

Table 9 Alarms parameters

Parameter Description

Alarms Activation of the alarm function. Any result 
below the lower threshold or above the 
upper threshold is displayed in red on the 
Results page.

Min Threshold
Max Threshold

Choice of lower and upper thresholds for 
each available wavelength, from -60 to +40 
dBm (selected with the direction keys.)
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Table 10 describes the Link parameters.

Table 10 Link parameters

Parameter Description

Fiber ID Specifies the name for the fiber

Fiber Number Specifies the fiber number.

Change Fiber Nbr Changes the Fiber number:
– No: The Fiber Number is not automatically modi-

fied.
– Increment: The fiber number is automatically 

incremented at each new file save.
– Decrement: The fiber number is automatically 

decremented at each new file save.
– User Defined: Use the Edit Number softkey to 

enter the increment/decrement value for fiber 
number.
Note: To decrement the number, enter the sign “-” 
before the number. For example: -1.
Min: -999/Max: 999/Auto: 0

Extremities are different In some cases, you may want to save different infor-
mation for the origin and the extremity of the cable.

To display/modify the data specific to the fiber (name 
and code), the direction must be temporarily 
changed. In the O->E direction, the information on the 
origin can be edited, and in the “E->O” direction, that 
on the extremity.

Cable ID Allows the entry of an identification of the cable using 
the Edition menu.

Direction The direction shows if the acquisition has been made 
from the origin to the extremity (A>B) or from the 
extremity to the origin (B>A). When different extremi-
ties are handled, changing direction makes it possible 
to see the parameters of the fiber for the other 
extremity.

Location A Specifies the name of the Location A of the link.

Location B Specifies the name of the Location B of the link.

Technician Id Specifies the name of the operator carrying out the 
measurement.

Job Id Allows a description of the measurement to be per-
formed.

Comment The Comment is specific to a fiber. This line is used 
to enter a new comment and not to display it. The 
comment appears at the top of the screen with the 
other parameters of the fiber.
The comment will remain available for the next acqui-
sition unless it is deleted. It is also saved when a 
trace is saved with a comment.
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Configuring the File parameters

The File storage parameters must be configured in order to define how the results will 
be saved on the platform.

In the Setup menu, select File.

Table 11 describes the Directory Configuration parameters.

Table 11 Directory Configuration parameters

Parameter Description

Dir. Naming Specifies the directory where files are saved.

1. Select File > Dir. Naming > [displayed directory]
2. Enter the directory. If left empty, the current directory is 

selected.
3. Press the Checkmark to validate.

Dir Displays the directory selected by default into which the 
file(s) are saved (the last directory selected.)
This parameter cannot be modified.

Filenaming Specifies the name of the file.

1. Select File > Filenaming > [displayed file naming format]
2. Using the keypad, either:
– Select the pre-defined parameters
– Enter a file name manually
– Press Auto to apply the name to the file by default:

Fiber [Cable_Id][File_-
Num]_[Lambda]_[Direction]

The name of the file is displayed in gray under the Filenam-
ing parameter.

Report As Specifies report types.

– txt file: A ‘.txt’ report file is also generated.
– pdf file: A ‘.pdf’ report file is also generated.
– json file: A ‘.json’ file is also generated.

If you select No for all the report types, only the Powermeter 
results are saved in a file with the ‘.lts’ extension.

Report Layout Displays the report layout.

If the txt, pdf, or json report is generated with the results file, 
the Report Layout parameters turn active. The options are:

– Standard — The report is saved in a standard text file.
– Consolidated — The results are consolidated and the 

report is saved in a text and/or PDF file.

Report Naming Displays the report naming format.
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Saving the configuration in a file
Once File and Measurement parameters have been configured, those parameters can 
be saved to a configuration file. This configuration file can then be recalled in order to 
be applied when the Powermeter measurements are performed.

To save parameters in a configuration file:

1 Press the Save softkey.
A keypad is displayed, as shown in Figure 37.

Figure 37 Save keypad

2 Enter a name for the configuration file (max 20 characters).

3 Press the Checkmark button to validate.

The configuration file is saved with the extension ‘.fo_cfg’ and can be recalled at any 
time from the File Explorer page.

Loading an existing configuration
You can load a configuration file previously created or available on the platform.

To load an existing configuration from the File Explorer:

1 Select the File softkey.

2 Select the desired configuration file.

3 Press Load > Load Trace + Config.

4 Press the Exit key, then select Setup to display the configuration parameters 
saved in the selected configuration file.



Chapter 3 Powermeter and VFL
Using the power meter

ONA-800 Getting Started Guide
Page 46 22142812, R016 August 2023

You can modify some acquisition or file storage parameters and save them in a new 
configuration file. See “Saving the configuration in a file” on page 45 for more informa-
tion. 

Results page
The results page provides the information relating to the measurement in progress, 
previously saved results, and the available commands for measuring and saving. 
Figure shows the Results page.

Figure 38 Results page

Result of the measurement in progress

The power measured by the power meter is displayed in large characters in the units 
selected in the configuration menu, along with:

• The mode of transmission of the signal measured
• The wavelength of the signal measured
• The reference level expressed in dB
• The level of Attenuation Compensation

Table of results

For each fiber being tested, the power meter displays a table of nine results corre-
sponding to the different possible wavelengths. The first four results are displayed on 
the screen. To scroll through the other results, use the direction key. The table shows 
the power measured in dBm, the relative power in dB, and the reference level in dBm 
(if units = dB), together with the mode.

NOTE
Most of the configuration files are available in disk/config.
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• When Keep Result is pressed, a measurement result is displayed in the table.
• The X softkey deletes all the results displayed in the table.
• If the Alarm function has been activated, any result that exceeds the selected 

thresholds appears in red in the table. Otherwise, the results are shown in green 
in the table.

• Results in the table are kept when the instrument is switched off.

Commands of the power meter parameters

When the Power meter function is selected, the following softkeys are available on the 
results page:

• Wavelength — Selects the wavelength
• Unit — Choice of the unit

On the results page, the following actions are available:

• Standard Reference — Selects the current result as a reference value to 
measure the insertion of a link. This reference is displayed under the measure-
ment result until a new reference is performed.

• Keep Result — Keeps the result on the corresponding line of the table.
• Clear Table — Deletes all the results displayed in the table. Clear Table appears 

as an X.

Performing a measurement
The Powermeter is started as soon as the function is activated in the Home menu.

Power measurement

The following procedure describes how to perform a power measurement.

To perform a power measurement

1 Connect the light source to be tested to the Powermeter connector, as described 
in “Connection to the power meter and VFL” on page 40.

2 In the configuration menu, choose the units
– dBm
– dB
– Watts.

CAUTION
Power measurement is automatically updated. The value <-60dB is displayed 
when the laser is switched off and if the source output is looped on to the power 
meter input.
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The measurement begins, and the results appear in the Results page and can be 
retained in the table. See “Table of results” on page 46 for more information.

Optical link loss

The following procedure describes how to set the zero value of the power meter.

Setting the zero value of the power meter

1 Fix the plug or cap over the optical input of the power meter so that no light can 
reach the photodiode of the power meter. If the zero adjustment is made without 
this plug, an error message may be displayed, as the photodiode will detect too 
much light.

2 On the Results page, press Setup > Zero and validate.

To carry out the reference measurement (1-jumper reference)

1 Fix the adapter corresponding to the jumper to the optical connector of the power 
meter.

2 Connect the jumper between the input of the power meter and the output of the 
source.

3 Configure the same wavelength on the source and the power meter.
The power measured is displayed on the results page of the power meter.

4 Press the Standard Ref softkey to save the result displayed as reference value.

After defining the reference value, proceed to the next procedure.

To perform measurements on the fiber under test

1 Fix the jumpers and connectors needed to connect the fiber to be tested between 
the source output and the power meter input.

2 In the set-up menu, select dB units.
The power displayed in the Power Meter window corresponds to the optical loss 
of the link tested. It can be displayed in the table, as described in “Table of results” 
on page 46.

Storing and reloading results
The following sections describe storing and reloading results.

CAUTION
Set the zero of the power meter before performing any low power level measure-
ment when accuracy is critical, as the noise from the photodiode may fluctuate 
over time and with temperature.
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Storing results
To save the results of a measurement, click on Save. The results are saved as 
configured in “Configuring the File parameters” on page 44

VFL function
The following sections describe the VFL function.

Visual Fault Locator function (VFL)
This function is used to emit a red light signal with a frequency of 1Hz or in continuous 
mode into a fiber to detect any defects in the dead zone of the reflectometer, or to iden-
tify it. This function is suitable for short fibers (length < 5 km) or the first few meters of 
a long fiber.

To emit a light signal into a fiber

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the Tests button and then select Fiber 1 (ONA-PMVFL) >. 

3 Press the VFL button of the Platform to activate the VFL. Figure 39 shows the 
VFL button.

Figure 39 VFL button

The Laser On icon appears in the system tray, as shown in Figure 40.

Figure 40 Laser On icon

4 To deactivate the VFL, press the VFL button for 3 seconds. The Laser On icon 
disappears from the system tray.

NOTE
Identification is facilitated by the blinking light in the fiber.

CAUTION
 Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure.
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Characteristics of the options
The following sections describe the specifications of the Powermeter and VFL options.

Powermeter option
Specifications given for 25oC, after 20 minutes stabilization time and after zero setting.

• Wavelength range: 800 to 1650 in steps of 1 nm
• Calibrated wavelengths: 850/1310/1490/1550/1625/1650 nm1

• Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)
• Input power range: -60 dBm to +10 dBm
• Maximum resolution: 0.01 dB/0.01 nW
• Measurement range: +5 to -50 dBm (-45 dBm from 800 to 1250 nm)
• Linearity within the measurement range: ± 0.2 dB

VFL option
• Wavelength: 650 nm
• Maximum power: 1.2 mW
• Length of fiber: up to 5 km
• Class 2 laser standards: IEC 60825-1 and FDA 21 CFR part 1040.10

1.Specifications guaranteed to the calibrated wavelengths, except for 1650 nm
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4

Chapter 4Smart Access Anywhere

This chapter explains how to configure and use the Smart Access Anywhere utility.

The topics discussed in this chapter are as follows:

• “About Smart Access Anywhere” on page 52
• “Licensing” on page 52
• “Downloading and extracting the utility” on page 52
• “Establishing a connection” on page 52
• “Launching the utility” on page 54
• “Displaying the instrument’s user interface” on page 56
• “Transferring files” on page 56
• “Displaying and modifying connection settings” on page 57



Chapter 4 Smart Access Anywhere
About Smart Access Anywhere

ONA-800 Getting Started Guide
Page 52 22142812, R016 August 2023

About Smart Access Anywhere
Smart Access Anywhere allows you to view and control the instrument’s user interface 
from a remote location using a workstation. In addition to configuring the instrument and 
performing tests, you can transfer files to and from the instrument using the instru-
ment’s file manager utility. You can also rename and delete files, or create, rename, and 
delete directories.

Licensing
To use Smart Access Anywhere, you must have a license. Contact your VIAVI sales 
representative for more information about obtaining a license.

Downloading and extracting the utility
The Smart Access Anywhere utility must be downloaded and extracted on the work-
station that you intend to use to connect remotely to the test instrument.

To download the utility

1 On your workstation, open a browser and type the following address:
http://smartaccess.updatemyunit.net

2 Click on the SmartAccessAnywhere_Vxx.xx.xx.zip link.

3 Select Save in the dialog box.
After the download is complete, the browser can be closed.

4 Go to the download directory, then extract the files in the zip file into the desired 
destination directory.

The utility is downloaded and extracted.

Establishing a connection
You can connect remotely to your test instrument using a 1) wired Ethernet connection, 
2) WiFi connection, or 3) Smartphone with Data Tethering. Before establishing a 

NOTE:
You do not need administrator privileges to install the utility on your workstation. The 
utility will be downloaded as a zip file.
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connection to the instrument, verify that port 22 (SSH) or 443 (HTTS) is open on your 
workstation.  

Wired Ethernet Connection
Figure 41 illustrates a test instrument connected to a workstation via a wired Ethernet 
connection to the Internet. Before establishing a wired connection, you need to 1) deter-
mine the instruments IP address and, 2) configure the network proxy (if a proxy is 
used). 

WiFi Connection
Figure 42 illustrates a test instrument connected to a workstation using a WiFi connec-
tion. 

NOTE:
To connect using WiFi, the WiFi option must be installed on the target test instrument. 
To order the option, or to determine whether a particular Smartphone has been quali-
fied by Viavi for the purpose of establishing remote connections to the instrument, 
contact VIAVI Customer Care at 1-866-228-3762 or www.viavisolutions.com.

Figure 41 Wired Ethernet Connection

Figure 42 WiFi Connection

http://www.viavisolutios.com
http://www.viavisolutios.com
http://www.viavisolutios.com
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Smartphone with Data Tethering
You can remotely connect to a test instrument using a Smartphone capable of data 
tethering and a WiFi hotspot or USB cable. 

Figure 43 illustrates a test instrument connected to a workstation using a WiFi hotspot 
provided by a Smartphone that supports data tethering.  

Figure 44 illustrates a test instrument connected to a workstation using a USB connec-
tion to a Smartphone that supports data tethering.  

Launching the utility
To use the Smart Access Anywhere utility, you must 1) establish a connect from your 
PC or mobile device to the test instrument, 2) launch the utility on the test instrument to 
obtain the required remote access code, and then 3) launch the utility on your PC or 
mobile device, and enter the remote access code that was obtained from the instru-
ment. 

Figure 43 WiFi Connection using Smartphone

Figure 44 USB Connection using Smartphone
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Launching the utility on the instrument

To launch the utility on your instrument

1 On the System page, select Remote.

2 Press Connect next to the SmartAccess Anywhere icon.
The connection to SmartAccess Anywhere Server will initiate.

3 After a connection is established to the server, the instrument displays a message 
with the code that is required to access to the equipment remotely.

4 If you will be accessing the instrument remotely from your workstation, write down 
or capture the code in some manner so you have it when you return to your work-
station. If another individual will be accessing the instrument remotely, provide the 
code to the individual.

Testing your connection
Before launching the utility on your workstation, you can also optionally test the connec-
tion between the workstation and target test instrument.

To test your connection

1 On your workstation, launch the Smart Access Anywhere utility.

2 Select Test connection.
The test automatically launches.

3 To display connection log details in real time, select the See full logs button.
The connection log appears, and provides the following information:
– Upload and Download speed (in Kbyte/s) from Device to server.
– Latency between Device and server (in ms).

4 After analyzing the results, do one of the following:
– Select the Clear test results button to delete the current table, and retest the 

connection if desired.
– If connection is deemed to be valid, enter the access code and establish 

connection.

Launching the utility on your PC or mobile device
After you establish a connection to your test instrument, you can launch the Smart 
Access Anywhere utility to update your instrument.
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1 Launch the Smart Access Anywhere utility:
– On your PC, go to the directory where you installed the utility, then double 

click SmartAccessAnywhere.exe.
– On your mobile device, press the Smart Access Anywhere icon.
The utility opens.

2 Enter the access code that was provided to you in the field provided on the upper 
part of the screen.

3 Click Connect to validate the code.

The Smart Access Anywhere screen appears.

Displaying the instrument’s user interface
After you launch the utility on your PC or mobile device, you can display the remote 
instrument’s user interface on your workstation’s display.

To display the instrument’s user interface

• On the Introduction page, click Remote Screen.
The user interface for the instrument appears on your workstation’s display.

The VNC icon in the system tray indicates that the remote screen is active.

Transferring files
Single files can be transfered one by one from your PC or mobile device to the instru-
ment, or from the instrument to your PC or mobile device.

To transfer a file to or from the workstation or instrument:

1 On the Introduction page, click File Transfer.
A two-pane window appears, showing the PC or mobile device directories (or 
storage devices) in one pane, and the instrument directories (or storage devices) 
in the other pane.

2 In the “source” pane (the pane that has the file that you want to transfer), double 
click on the directory or storage device, then select the file to be transferred.

3 In the “destination” pane (the pane with the directory that you want to transfer the 
file to, select the destination directory for the file.

NOTE:
After upgrading or rebooting a remote instrument, please wait at least two minutes 
before re-establishing the link between your workstation and the test instrument.
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4 Do one of the following:
– If you are transferring a file from your PC or mobile device to the instrument, 

click Upload.
– If you are transferring a file from your instrument to the workstation, click 

Download.
A dialog box appears asking you to verify the destination that you selected for the 
transferred file. If it is the correct destination, click OK.

5 Click Save to transfer the file.

A message will appear at the bottom of the screen providing details concerning the 
status of the file transfer. After the transfer is complete, the message disappears and 
the transferred file is underlined in the workstation or instrument’s file manager.

Displaying and modifying connection settings
You can review information about the current remote session at any time.

To display session information

• Select the Session icon key.

Session details appear. This page gives information on the connection in real time.

To modify connection settings

1 Select the Session icon.

2 Disconnect the session using the Disconnect button.

3 On the session screen, select the Network Settings icon.
The connection settings screen appears. The default connection is defined as 
Smart-guess (default).

4 To modify the settings, select Forced settings, and then modify SSI tunnel port 
and/or Internet proxy as needed.
The Internet proxy configuration is available exclusively if the port selected is 
Alternative port (443) and if HTTPS packing is selected.

5 After configuring the settings, select Back to main page.

NOTE:
If the default parameters need to be modified, it is recommended you discuss it with 
your local network administrator.
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A

Appendix A Physical Specifications

This appendix lists the physical specifications of the ONA-800. Topics covered include:

• “ONA-800A-MF” on page 60
• “Optional modules” on page 60 
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ONA-800A-MF
Table describes the physical specifications of the ONA-800A-MF.

Optional modules
The following sections describe the specifications of optional modules.

Table 12 Physical Specifications — ONA-800A-MF

Parameter Specification

Dimensions

Height 170 mm (6.7 in)

Width 269 mm (10.6 in)

Depth1

1. Depth will vary depending on the solution module.

With expansion modules 91 mm (3.6 in)

Without expansion modules 58 mm (2.3 in)

Weight 2.0 kg (4.4 lb)

Battery2

2. Battery life and charging time depend on the types of tests performed. Specified temperatures are internal to bat-
tery.

Type 14.4 V, 6.7 A-h, 92 Wh, Lithium Ion

Charging Time

One battery, 100% > 2.2 hours

Charging Temperature 0 to 45oC (32 to 113oF) 

Discharging Temperature 0 to 60oC (50 to 240oF) 

Operating Temperature3

3. Operating Temperature is for base only. See the module documentation for more information.

0 to 40°C (32 to 104°F) AC power condition
10 to 40°C (50 to 104°F) Battery power condition

Storage Temperature -20 to 60°C (-4 to 140°F)
IMPORTANT: VIAVI strongly recommends storing the 
battery pack in a low-humidity ≤80% RH, low-
temperature <21°C (70°F) environment.

Environment

Maximum Humidity 95% RH non-condensing

Shock and Vibration MIL-PRF-28800F

Drop MIL-PRF-28800F, ETSI EN 300 019-2-7

Altitude 2000 m (6,652 ft)
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Solution modules
You can attach the following solution modules:

• SPA06MA
• SPA06MA-O
• RA44MA-O
• RA18MA-O
• 400G Module

For:

• SPA06MA, SPA06MA-0, RA44MA-0, and RA18MA-0 specifications, refer to the 
OneAdvisor 800 Radio Analysis Module User's Guide. 

• 400G Module specifications, refer to the OneAdvisor 800 400G Module User’s 
Guide

• Supporting data sheets are available at www.viavisolutions.com.

Fiber modules
The following sections describe fiber modules that plug into the optional Fiber Module 
Carrier module.

OSA and OTDR

For OSA and OTDR module specifications, refer to the 8100 V2 Modules Series User 
Guide. Supporting data sheets are available at www.viavisolutions.com.

DTS

For Distributed Temperature Sensing (DTS) module specifications, refer to the DTSS 
and STS Module User Manual. Supporting data sheets are available at 
www.viavisolutions.com.

ODM

For Optical Dispersion Measurement (ODM) module specifications, refer to the ODM 
Module User Manual. Supporting data sheets are available at www.viavisolutions.com.

Expansion Modules
The following sections describe Expansion modules.

https://www.viavisolutions.com
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CAA modules

For Cable and Antenna Analyzer (CAA) modules, refer to the CAA06M Cable and 
Antenna Analyzer Quick Start Guide. Supporting data sheets are available at 
www.viavisolutions.com.

OTDR and MPO Switch

For Optical Time Domain Reflectometer (OTDR) and Multi-Fiber Push On (MPO) 
Switch specifications, refer to the OTDR Functions, Options and Software Applications 
User Manual. Supporting data sheets are available at www.viavisolutions.com.

OSA, OCV, and OCC modules

For Optical Spectrum Analyzer (OSA), Optical Channel Verifier (OCV), and Optical 
Channel Checker (OCC) specifications, refer to the corresponding user manuals. 
Supporting data sheets are available at www.viavisolutions.com.

Timing Expansion Module (TEM)

For TEM specifications, refer to the T-BERD/MTS/MAP-2100 GNSS and Timing 
Expansion Module V2 User Manual. Supporting data sheets are available at 
www.viavisolutions.com.

Power Expansion Module (PEM)

Table 13 describes the physical specifications of the PEM.

Table 13 ONA-MF2-PEM physical specifications

Parameter Specification

Dimensions

Height 130 mm (5.1 in)

Width 138 mm (5.4 in)

Depth 41 mm (1.6 in)

Battery

Type 14.4 V, 6.7 A-h, 92 Wh, Lithium Ion

Charging Time > 2.2 hours

Charging 
Temperature

0 to 45oC (32 to 113oF)

Discharging 
Temperature

0 to 60oC (32 to 140oF)

https://www.viavisolutions.com
https://www.viavisolutions.com
https://www.viavisolutions.com
https://www.viavisolutions.com
https://www.viavisolutions.com
https://www.viavisolutions.com
https://www.viavisolutions.com
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Storage 
Temperature

-20 to 60°C (-4 to 140°F)
IMPORTANT: VIAVI strongly recommends storing the battery pack 
in a low-humidity ≤80%RH, low-temperature <21°C (70°)F 
environment.

Environment

Maximum Humidity 95% RH non-condensing

Shock and Vibration MIL-PRF-28800F

Drop MIL-PRF-2880, ETSI EN 300 019-2-7

Storage 
Temperature

-20 to 60°C (-4 to 140°F)

Altitude 2000 m (6,652 ft)

Table 13 ONA-MF2-PEM physical specifications

Parameter Specification
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